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Overview 
The Cobra 8.4 Cumulative Update 10 release includes all of the enhancements, software issues resolved, 
and database changes that were made in Cobra 8.4 CU 08 through CU 10. 

Custom Programs Affected 
Sometimes an update can cause custom programs and reports to stop working as expected. Before 
applying this update, consider whether you have any custom programs or reports in the application area 
affected by the update. If so, contact Deltek Customer Care at http://support.deltek.com before you install 
the update. 

 

Viewing the Online Help 
If you use Internet Explorer and the online help does not display correctly, you need to turn off 
Compatibility View for the browser. Click Tools » Compatibility View settings, and clear the Display 
intranet sites in Compatibility View check box. Then refresh the browser. Make sure you remove 
deltek.com (if listed) from the Websites you have added to Compatibility View list. You could also elect 
to use hosted help or the FQDN of your server in the URL (for example, server.domain) to bypass this 
issue. Depending on your Internet Explorer security settings, you may be prompted to “Allow blocked 
content” when viewing the online help locally. The Cobra 8.4 Help System URL is 
https://help.deltek.com/Product/Cobra/8.4/GA. 

Depending on your Internet Explorer security settings, you may be prompted to “Allow blocked content” 
when viewing the Cobra Online Help locally. This only affects Internet Explorer.  

You may also access the online help using Edge, Chrome, and Firefox. 

Attention: For steps to install the cumulative update, see Appendix A: Download and Install the 
Cumulative Update. 

http://support.deltek.com/
https://help.deltek.com/Product/Cobra/8.4/GA/Cobra%208.0%20Help%20System.html
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Cobra 8.4 Cumulative Update 10 
Released: March 4, 2022 

Enhancements 

Support for Concurrent Forecast Calculations 
Cobra now supports concurrency in running forecast calculations on batches of control accounts. For 
example, a project can be split into multiple jobs, with each job processing a different batch of control 
accounts concurrently. 

To use this feature, you must understand the following information and requirements: 

 You must know the requirements and steps to set up your environment to run a concurrent 
process. 

 You are running the concurrent forecast calculations against a single project. 

 You are not running the concurrent forecast calculations against Frozen Forecast classes. 

 The apportionment mapping target is set to <Same as Source> or <Same as Source> \ WP for 
all control accounts in the apportionment mapping definition. 

 You have specified the number of control accounts to process per batch in the Control Accounts 
per queue field on the Data Access tab of the Application Preferences dialog box. 

After you set up your environment for the concurrent forecast calculations and you run the Calculate 
Forecast Wizard, the Run page displays after the Forecast Class Selection page. 

 

 
Run Page of the Calculate Forecast Wizard  

Note: If you select a forecast class that uses the forecast method PF=Unit input on the Forecast 
Class Selection page, the Run page displays after the Manual Performance Factors page. 

https://help.deltek.com/Product/Cobra/8.4/GA/Concurrency%20Requirements.html
https://help.deltek.com/Product/Cobra/8.4/GA/Implementing%20Concurrency.html
https://help.deltek.com/Product/Cobra/8.4/GA/Data%20Access%20Tab%20of%20the%20Application%20Preferences%20Dialog%20Box.html
https://help.deltek.com/Product/Cobra/8.4/GA/Calculate%20Forecast%20Wizard.html
https://help.deltek.com/Product/Cobra/8.4/GA/Calculate%20Forecast%20Wizard.html
https://help.deltek.com/Product/Cobra/8.4/GA/Run%20Page%20of%20the%20Calculate%20Forecast%20Wizard.html
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If you select the Send to process server check box, Cobra groups the control accounts into multiple 
batches (according to the value specified in the Control Accounts per queue field on the Data Access 
tab of the Application dialog box), queues the forecast calculation job to the Process Server, and displays 
the Process Complete page immediately. 

 

Data Access Tab of the Application Preferences Dialog Box 

 

Loading Budget Resources during Schedule Integration through the 
Cobra Web Services 
When running the Schedule Integration through the Cobra Web Services, you can now define how budget 
resources are imported into the Cobra project from the scheduling tool. 

The following new parameters are added: 

 LoadOptions: This parameter determines how the budget class will be imported to the budget 
resource assignment data. This parameter can contain one of the following: 

 LoadAllBudgetIntoDefaultClass: This value informs Cobra to import all resource 
assignments into the same class. 

 LoadBudgetClassFromField: This value informs Cobra to use a schedule field that has the 
budget classes to import resource assignments. 

 LoadFromField: This parameter determines the schedule field that has the budget class that will 
be imported to the budget resource assignment data.  

 LoadFilterClassList: This parameter determines the list of classes that will only be included in 
importing budget resource assignment data.  

Attention: For more information, see the “Concurrent Forecast Calculations” and “Concurrency in 
Cobra” help topics in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.4/GA/Concurrent%20Forecast%20Calculations.html
https://help.deltek.com/Product/Cobra/8.4/GA/Concurrency%20in%20Cobra.html
https://help.deltek.com/Product/Cobra/8.4/GA/Concurrency%20in%20Cobra.html
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The following Web Service Client API Help topics have been updated for this enhancement: 

 IntegrateProjectDataServiceArguments.BudgetCriteria Class: The new parameters are added to 
the BudgetCriteria class in this topic. 

 IntegrateProjectDataServiceArguments Class: The new parameters are referenced as the Budget 
property of IntegrateProjectDataServiceArguments class in this topic. 

Software Issues Resolved 

API » Web Services 

Defect 1586066  

Description: Saving a workflow took longer to complete. 

Customers Impacted: This defect affects customers who integrate Cobra with PM Compass to use 
workflows. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

File » Integration Cost Data Export 

Defect 1485584  

Description: When you ran the Cost Data Export process to export to a JSON file, the ReportingPeriodID 
value was missing if the total dollars of the combined actual classes totaled to zero while the hours on 
those same classes did not. 

Customers Impacted: This defect affects customers who use the Cost Data Export process. 

Workaround Before Fix: None. 

Files Updated: 

 PPM.CommonData.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 

Note: These parameters correspond to the fields in the Budget group box on the Resource 
Assignments page of the Integration Wizard. 

http://help.deltek.com/Product/Cobra/8.4/GA/api/html/R_Project_Web_Service_ClientAPI.htm
http://help.deltek.com/Product/Cobra/8.4/GA/api/html/T_Cobra_Model_WebService_IntegrateProjectDataServiceArguments_BudgetCriteria.htm
http://help.deltek.com/Product/Cobra/8.4/GA/api/html/T_Cobra_Model_WebService_IntegrateProjectDataServiceArguments.htm
https://help.deltek.com/Product/Cobra/8.4/GA/Resource%20Assignments%20Page%20of%20the%20Integration%20Wizard.html
https://help.deltek.com/Product/Cobra/8.4/GA/Resource%20Assignments%20Page%20of%20the%20Integration%20Wizard.html
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File » Integration Wizard-Project Data 

Defect 886533  

Description: When you ran the Integration Wizard to load Microsoft Project data from an XML file, the 
Cobra time-phasing spread did not match the time-phasing of data in Microsoft Project. 

Customers Impacted: This defect affects customers who load data from MS Project XML files using the 
MS Project Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

Defect 1601367  

Description: When you ran the Integration Wizard, loaded an empty activity file on the Project Selection 
page, and selected the Delete Control Accounts and Work Packages no longer in the schedule 
option on the Change Control page, Cobra did not delete the work packages. 

Customers Impacted: This defect affects customers who use the Transaction–File Integration Wizard. 

Workaround Before Fix: You can load a transaction file with a single record that creates dummy work 
packages. When the process is completed, the filtered work packages will be deleted. You can then 
delete the dummy work packages. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 1603521  

Description: When you ran the Integration Wizard to load schedule from Open Plan, Cobra changed the 
work package Baseline Start date to Open Plan's Schedule Start date of the baseline activity even if the 
Prevent editing of historical time phased values option on Project Preferences tab of the Project 
Properties dialog box was selected, and the baseline start date was set prior to the status date. 

Customers Impacted: This defect affects customers who use the Open Plan–Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

Defect 1590968  

Description: When you ran the Integration Wizard to load an existing configuration and then updated the 
selection in the Force existing Work Package dates to match the schedule for field on the Change 
Control page, Cobra did not save your changes. 

Customers Impacted: This defect affects customers who use the Transaction–File Integration Wizard. 

Workaround Before Fix: Create a new configuration instead of loading an existing one. 

Files Updated: 
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 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Installation 

Defect 1599389  

Description: Cobra was installing the old version of the MSCOMCTL.OCX file used by the EPM Security 
Administrator tool. 

Customers Impacted: This defect affects all customers. 

Workaround Before Fix: Download the latest version of the MSCOMCTL.OCX file from the Microsoft 
website and install it. 

Files Updated: 

 DeltekCobra84.exe 

Project Processes » Freeze Forecast 

Defect 169968  

Description: When you ran the Freeze Forecast Wizard, Cobra encountered the "Forecast class XXX are 
not at the same level as Cost Set XXX” error if the included forecast classes in the Forecast Cost Set 
pane were set to both control account and work package levels, and a frozen forecast class set at the 
control account level was selected in the Copy To class field in the Frozen Forecast Class pane. 

Customers Impacted: This defect affects customers who use the Freeze Forecast Wizard. 

Workaround Before Fix: Run the Reclass Wizard to copy the forecast class at the work package level to 
a forecast class at the control account level, and then run the Freeze Forecast Wizard. 

Files Updated: 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Project Processes » Reclass 

Defect 1605257  

Description: When you ran the Reclass Wizard and the target class type was Actual or Progress, Cobra 
encountered the "LCCALENDAR' is not found" error if one of these scenarios applied: 

 The Copy resource assignment codes from option on the Options page was set to Target. 

 The target class and the source class were at different levels. 

Customers Impacted: This defect affects customers who use the Reclass Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 
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 Cobra.Process.dll 

Defect 1609692  

Description: When you ran the Reclass Wizard, the reclass values were incorrect if: 

 The Source Class page was set to Copy, the Target Class page was set to Replace existing, 
and the target class and the source class were at different levels. 

 The project contained records with code that was a subset of another code (for example, ASTRO 
and ASTRO1). 

 The target class was a budget or forecast class, and the calendar dates were different from the 
source class calendar. 

Customer Impacted: This defect affects customers who use the Reclass Wizard. 

Workaround Before Fix: None. 

Files Updated:  

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 1597539  

Description: When you ran the Reclass Wizard, Cobra did not create the target resource if: 

 The Source Class page was set to Copy. 

 The Target Class page was set to Replace existing. 

 The Date Range page was not set to Reclass all periods in your project. 

Customers Impacted: This defect affects customers who use the Reclass Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Reports » Reports 

Defect 621652  

Description: When you ran the IPMR CPR Format 1 or CPR Format 1 report using a master project, the 
Target Profit or box5d amount on the generated report was incorrect. 

Customers Impacted: This defect affects customers who run the IPMR CPR Format 1 or CPR Format 1 
report. 

Workaround Before Fix: None. 

Files Updated: 

 cpr format 1.xlsx 
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 IPMR CPR Format 1.xlsx 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 

Documentation Changes 
This section includes details of section changes in the printed documentation.  

Document Details 

Cobra 8.4 
Online Help 

Created the following help topics for the Concurrent  Forecast Calculations feature: 

Concurrent Forecast Calculations 

Run Concurrent Forecast Calculations 

Run Page of the Calculate Forecast Wizard 

Cobra 8.4 
Installation 
Guide 

Updated Step 4 of the “Add a New Data Source” section with instructions applicable 
to every database server type. 
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Cobra 8.4 Cumulative Update 09 
Released: February 4, 2022 

Enhancements 
There are no enhancements in this release. 

Software Issues Resolved 

Documentation 

Defect 1589598  

Description: The Cobra Help did not contain sufficient information about loading actual cost records from 
a SQL Server database table during integration. 

Customers Impacted: This defect affects all customers. 

Workaround Before Fix: None. 

Additional Notes: The steps to load actual costs from a SQL Server database table is now documented 
in the "Create an MS SQL Database Connection to Load Actual Costs" help topic. 

Files Updated: 

 Create a MS SQL Database Connection to Load Actual Costs.html 

 Database Table Selection Page of the Integration Wizard Actuals.html 

 File Selection Page of the Integration Wizard Actuals.html 

 Loading Actual Cost Records from a Database Table.html 

File » Integration Cost Data Export 

Defect 1510620  

Description: When you ran the Cost Data Export process to export to a JSON or DCDE file, the earned 
values for the Management Reserve (MR) and Undistributed Budget (UB) included zero values for the 
fields that were not applicable. 

Customers Impacted: This defect affects customers who use the Cost Data Export process. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

https://help.deltek.com/Product/Cobra/8.4/GA/Create%20a%20MS%20SQL%20Database%20Connection%20to%20Load%20Actual%20Costs.html
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File » Integration wInsight 

Defect 1592177  

Description: When you ran the wInsight Export process, the UNCEFACT was not generated if the 
narrative text contained non–breaking spaces. 

Customers Impacted: This defect affects customers who use the wInsight Export process. 

Workaround Before Fix: Edit the narrative text by removing the non–breaking spaces and replacing 
them with spaces. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 562503  

Description: When you ran the wInsight Export process, the UNCEFACT was not generated if the control 
account code in the Spreadsheet pane of the Project view contained special characters (&, >, <, ", ', |). 

Customers Impacted: This defect affects customers who use the wInsight Export process. 

Workaround Before Fix: Edit the control account code by removing the special characters. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 1321280  

Description: When you ran the wInsight Export process to add dummy work packages for actuals and 
the Level at which to capture actual costs field on Files tab of the Project Properties dialog box was set 
to Both Control Account & Work Package, the generated XML file did not contain burden values for 
budget and progress. 

Customers Impacted: This defect affects customers who use the wInsight Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 
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File » Integration Wizard-Project Data 

Defect 1568599  

Description: When you ran the Integration Wizard and the Prevent editing of historical time phased 
values option on the Project Preferences tab of the Project Properties dialog box was selected, Cobra 
updated the baseline dates before the status date. 

Customers Impacted: This defect affects customers who use the Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

Reports » Report Wizard 

Defect 460631  

Description: When you opened the Manage Filters dialog box, report filters to which you did not have 
access were displayed. 

Customers Impacted: This defect affects all non-Cobra administrators using the Manage Filters dialog 
box. 

Workaround Before Fix: None. 

Files Updated:  

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Reports » Reports 

Defect 401984  

Description: The Description column header for Export Rates report was incorrect. 

Customers Impacted: This defect affects customers who generate Export Rates report. 

Workaround Before Fix: Correct the column heading in the generated report. 

Files Updated:  

 export rates.xlsx 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 
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Documentation Changes 
This section includes details of section changes in the printed documentation.  

Document Details 

Cobra 8.4 
Online Help 

 Made the following updates to the Cobra Online Help for Defect 158959: 

 Documented steps to load actual costs from a SQL Server database table 
in the "Create an MS SQL Database Connection to Load Actual Costs" 
help topic. 

 Added a note about creating an MS SQL database connection to load 
actuals costs to the following help topic: 

 “Database Table Selection Page of the Integration Wizard Actuals” 

 “File Selection Page of the Integration Wizard Actuals” 

 “Loading Actual Cost Records from a Database Table” 

https://help.deltek.com/Product/Cobra/8.4/GA/Create%20a%20MS%20SQL%20Database%20Connection%20to%20Load%20Actual%20Costs.html
https://help.deltek.com/Product/Cobra/8.4/GA/Database%20Table%20Selection%20Page%20of%20the%20Integration%20Wizard%20Actuals.html
https://help.deltek.com/Product/Cobra/8.4/GA/File%20Selection%20Page%20of%20the%20Integration%20Wizard%20Actuals.html
https://help.deltek.com/Product/Cobra/8.4/GA/Loading%20Actual%20Cost%20Records%20from%20a%20Database%20Table.html
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Cobra 8.4 Cumulative Update 08 
Released: December 20, 2021 

Enhancements 

BCR Analysis Report Enhancements 
This release contains updates to support running of the Budget Change Request (BCR) Analysis report in 
PM Compass. 

 

Allow Freezing of Multiple Columns and Rows in a Report Template 
File 
You can now freeze multiple rows and columns in a report template file. When you run the Report Wizard, 
the changes you made to the report template file are applied to the generated report. 

Support for Primavera P6 20.12 
Cobra now supports Primavera® P6 20.12 beginning with version 8.4 Cumulative 08 onwards. 

Match Work Package Forecast Dates with Dates Loaded from a 
Schedule during Integration 
Cobra now allows you to match work package forecast start and finish dates with dates loaded from a 
schedule during integration. In order to support this feature, the Force existing Work Package baseline 
dates to match the schedule option on the Change Control page of the Integration Wizard has been 
changed to Force existing Work Package dates to match the schedule for, with a list of dates 
displayed depending on the dates being loaded from a schedule. 

Attention: See “Cobra Integration Updates” in the Deltek PM Compass 8.2 Cumulative Update 05 
Release Notes for Lockheed Martin Aeronautics. 
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Change Control Page of the Integration Wizard 

 

Software Issues Resolved 

API » Web Services 

Defect 1544675  

Description: When using Costpoint version 8.1 or earlier, the Integration-Actual Costs process with 
control account code assignments did not work. 

Customers Impacted: This defect affects customers integrating with Costpoint. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WebService.Host.exe 

 Cobra.WebService.dll 

File » Integration Cost Data Export 

Defect 1409679  

Description: When you ran the Cost Data Wizard on a master project while in the Master Projects view, 
Cobra encountered an application error. 

Customers Impacted: This defect affects customers who use the Cost Data Wizard. 

Note: For more information, see the “Change Control Page of the Integration Wizard” help topic. 

https://help.deltek.com/Product/Cobra/8.4/GA/Change%20Control%20Page%20of%20the%20Integration%20Wizard%20Scheduling%20Tools.html
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Workaround Before Fix: Run the Cost Data Wizard while in the Projects view instead of the Master 
Projects view. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

File » Integration Wizard-Project Data 

Defect 1431445  

Description: When you performed multi-project concurrent integration using the Integration Wizard to 
load status data and selected the Send to process server option on the Save and Load page, Cobra 
encountered errors. 

Customers Impacted: This defect affects customers who run concurrent Cobra processes. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

Defect 1550439  

Description: When you ran the Integration Wizard to import one file with activity and resource 
assignment data, and a result field on the Import File Field Mapper page contained "BE" within the result 
name, the integration failed with the following error: "SQL: Column '<resultname>' is not found." 

Customers Impacted: This defect affects customers who use the Integration Wizard. 

Workaround Before Fix: Use two separate files during import (one activity file and one resource 
assignment file). 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Project Processes » Assignment Export or Import 

Defect 186735 

Description: When you ran the Assignment Export Wizard and the resource exported contained special 
characters (&, <,>, ', ", ..., ’), Cobra displayed an unexpected token error message. 

Customers Impacted: This defect affects customers who use the Assignment Export Wizard. 
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Workaround Before Fix: Remove the special character in the resource name. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 

Documentation Changes 
This section includes details of section changes in the printed documentation.  

Document Details 

Cobra 8.4 
Installation 
Guide  

 Added Primavera P6 20.12 to the Supported Deployment Technology table. 

Cobra 8.4 
Technical 
Overview and 
System 
Requirements 
Guide 

 Added Primavera P6 20.12 to the Supported Deployment Technology table. 

Cobra 8.4 
Online Help 

 Added a note about the freezing multiple rows and columns in a report 
template file to the “Report Templates” help topic. 

 Added a note about specifying the data source in 
ServiceIdentityData.DataSourceKey property if Cobra is configured under 
Standalone or Server Deployment environment and that it has multiple data 
sources to the following help topics: 

 Connecting to the Cobra Web Service Host 

 Explaining the SampleClientAPI Code  

https://help.deltek.com/Product/Cobra/8.4/GA/Report%20Templates.html
https://help.deltek.com/Product/Cobra/8.4/GA/Connect%20to%20the%20Cobra%20Web%20Service%20Host.html
https://help.deltek.com/Product/Cobra/8.4/GA/Explaining%20the%20SampleClientAPI%20Code.html
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Appendix A: Download and Install the 
Cumulative Update  

Download the Cumulative Update 
1. From Internet Explorer, go to https://dsm.deltek.com.  

2. Click Run Deltek Software Manager.  

3. Log in using your Deltek Customer Care Connect credentials.  

4. In the left pane of the Deltek Software Manager, expand your Deltek product.  

5. Expand the Cumulative Updates folder for your product, and select the update to download.  

6. Click Download at the bottom of the screen. 

Install the Cumulative Update 
Use the instructions below that apply to the Cobra version you use. 

 

For Cobra 8.x and Higher 
The instructions for installing an update for Cobra 8.x and higher depend on your type of deployment. Use 
the instructions below that apply to your deployment scenario. 

 

If You Use a Deployment Server 

To install on the server: 

1. Verify that Cobra is not running.  

2. Launch the update on the server.  

 

3. The Welcome screen displays the current build, along with the new build being installed by the 
update. Click Next to begin the installation.  

4. The installation wizard installs all necessary files and displays the Update Complete form.  

5. Click Finish.  

Note: You must install the entire update package. If an update addresses more than one defect, you 
cannot fix one defect at a time. 

Note: You must install the entire update package. If an update addresses more than one defect, you 
cannot fix one defect at a time. 

Note: If the update detects that Cobra is already running, you will see a prompt asking if you want to 

close Cobra. Choose Yes to start the installation or choose No to cancel the installation. 

https://dsm.deltek.com/
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6. Depending on the type of update, a reboot may be required. If the option to reboot your computer 
is enabled, select it and click Finish.  

7. Launch the Deltek Cobra shortcut on client workstations to initiate the update. 

To install on a client workstation: 

1. Launch the Deltek Cobra shortcut. Cobra detects that an updated version is available and 
displays the prompt: Do you want to install the upgrade?  

2. Choose Yes to start the installation or choose No to cancel the installation. When the installation 
is completed, the installation wizard closes.  

3. Launch the Deltek Cobra shortcut to log into Cobra. 

If You Have an N-Tier Deployment 

To install on the server: 

1. Verify that Cobra is not running.  

2. Launch the update on the server.  

 

3. The Welcome screen displays the current build, along with the new build being installed by the 
update. Click Next to begin the installation.  

4. The installation wizard installs all necessary files and displays the Update Complete form.  

5. Click Finish. 

6. Depending on the type of update, a reboot may be required. If the option to reboot your computer 
is enabled, select it and click Finish. 

7. Launch the Deltek Cobra shortcut on n-tier client workstations to initiate the update. 

To install on an n-tier client workstation: 

1. Launch the Deltek Cobra shortcut. Cobra detects that an updated version is available and 
displays the prompt: Do you want to install the upgrade?  

2. Choose Yes to start the installation or choose No to cancel the installation. If you choose Yes, 
the installation wizard copies the updated DeltekCobraWorkstation.exe file locally and 
automatically begins installing files. When the installation is completed, the installation wizard 
closes.  

3. Launch the Deltek Cobra shortcut to log into Cobra. 

If You Have a Terminal Services/Citrix Deployment 

To install on the deployment server: 

1. Verify that Cobra is not running.  

2. Launch the update on the server. 

Note: If the update detects that Cobra is already running, you will see a prompt asking if you want to 

close Cobra. Choose Yes to start the installation or choose No to cancel the installation. 
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3. The Welcome screen displays the current build, along with the new build being installed by the 
update. Click Next to begin the installation.  

4. The installation wizard installs all necessary files and displays the Update Complete form.  

5. Click Finish. 

6. Depending on the type of update, a reboot may be required. If the option to reboot your computer 
is enabled, select it and click Finish. 

7. Log on as a Local Administrator on the Terminal Server/Application Server and install the update. 

To install on the Terminal Server/ Application Server (the server on which the Cobra client runs): 

1. Log on to the Terminal Server using an account that has Local Administrator privileges. When the 
setup launches, the installation program installs all necessary files and any registry updates and 
makes these changes available to all users who will subsequently log on to the Terminal Server 
session to run Cobra.  

2. Ensure that no instance of Cobra is running.  

3. Browse to the shared Cobra Workstation folder (usually located on the deployment server, as 
\\{DeploymentServerName}\CobraWorkstation\DeltekCobraWorkstation.exe).  

4. Launch the DeltekCobraWorkstation.exe file to install the update. The Welcome screen displays, 
showing that the update is available.  

5. Click Next to start the installation.  

6. When the installation completes, launch the Deltek Cobra shortcut to log into Cobra and confirm 
that the update is installed, meaning that users can now launch Cobra via Terminal 
Services/Citrix sessions. 

If You Have a Standalone Deployment 

To install on the workstation: 

1. Verify that Cobra is not running.  

2. Launch the update on the server.  

3. The Welcome screen displays the current build, along with the new build being installed by the 
update. Click Next to begin the installation.  

4. The installation wizard installs all necessary files and displays the Update Complete form.  

5. Click Finish.  

6. Depending on the type of update, a reboot may be required. If the option to reboot your computer 
is enabled, select it and click Finish. 

7. Launch the Deltek Cobra shortcut to log into Cobra. 

Confirm that the Cumulative Update is Installed 

1. Click  » Help » About Deltek Cobra. 

Note: If the update detects that Cobra is already running, you will see a prompt asking if you want to 

close Cobra. Choose Yes to start the installation or choose No to cancel the installation. 
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2. Check that the version number reflects the installation of the update. 
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Appendix B: For Additional Information 

Deltek Support Center 
The Deltek Support Center is a support Web site for Deltek customers who purchase an Ongoing Support 
Plan (OSP).  

The following are some of the many options that the Deltek Support Center provides: 

 Search for product documentation, such as release notes, install guides, technical information, 
online help topics, and white papers 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers through the 
Deltek Support Center Community 

 Access Cloud-specific documents and forums 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Subscribe to Deltek communications about your products and services 

 Receive alerts of new Deltek releases and hot fixes 

 Initiate a Chat to submit a question to a Customer Care analyst online 

 

Access Deltek Support Center 

To access the Deltek Support Center:  

1. Go to https://deltek.custhelp.com. 

2. Enter your Deltek Support Center Username and Password. 

3. Click Login. 

 

 

Attention: For more information regarding Deltek Support Center, refer to the online help available 
from the Web site. 

Note: If you forget your username or password, you can click the Need Help? button on the login 
screen for help. 

https://deltek.custhelp.com/


 

 

About Deltek 
Better software means better projects. Deltek delivers software and information solutions that enable 
superior levels of project intelligence, management and collaboration. Our industry-focused expertise 
makes your projects successful and helps you achieve performance that maximizes productivity and 
revenue. www.deltek.com 

 

http://www.deltek.com/
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